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MODULE 1: Computer Literacy 

Trainer The trainer does not need to have a thorough knowledge 

of computers. However, a good knowledge of Google and 

Microsoft Word is required. 

Participants Please make sure that the participants have the A2 level 

and that they are legally present in the host country. It is 

also better if the participants have the right to work, 

because they can put into practice everything they learn.  

Short description of the 

content 

 

 

 Basic knowledge of Microsoft Word software 

 Create a Gmail account  

 How to find a job on Internet and apply online 

Having knowledge on all these subjects is extremely 

important because job offers are often dematerialized 

today. 

Work plan for the Module The "Computer Literacy" module aims to give basic digital 

knowledge to the target audience. This knowledge is 

directed to help the socio-professional integration of 

refugees/migrants. This guide is addressed to 

professionals working with the public in question. 

The module is divided into three sessions (4hrs/session) 

and is addressing different themes. Thus the first four-

hour session is focusing on Microsoft Word software, as 

well as the creation of an e-mail account. The second 

session focuses on online job search, as well as the online 

application form. In total this module includes 12 hours of 

training and requires beneficiaries have the use of a 

computer and internet throughout its course. 

 Each session has a theme as described above 

 The module is divided into 2 sessions of 6 hours 

each for a total of 12 hours of training. 

 The theoretical explanations are directly applied 

by the trainees who have computers at their 

disposal. Format: learning by doing. 

 A 15-minute break every two hours is 

recommended 

Learning outcomes (goals) After this module the participants will: 

 Use Word software, create alerts, create and use a 

mail box 
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Be able to look for a job on the internet and to offer their 

candidature online 
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Session 1: Digital Availability 
 

Activity 1: Create a Gmail account 
 

Title Create a Gmail Account 

Overview To be able to access the job the beneficiaries must at 

least be able to write a CV, Letter of Motivation, and have 

an email address to receive all the information related to 

the job search. This 4-hour session helps to explain to the 

audience the importance of these tools. The training 

encourages them to take control of these tools for daily 

use. 

This entire session is directly put into practice by the 

public. The trainer is responsible for conveying general 

information and answering questions from the public. 

This activity allows participants to create a Gmail account 

and to learn how to use it. The instructions given to the 

trainer are written in a way that allows her/him to just 

read them aloud step-by-step to the participants. 

Type of activity Experimental exercise 

Time required 120 minutes 

Size of the group 10 people 

Materials needed 10 Computers w/access to internet 

 

Procedure: Preparation  

Though most of the participants using a smartphone may already have a Gmail 

account, they might have forgotten their password to enter their email in a device 

other than their phone.  Identify participants that have mastered the email activity 

on a computer and ask them to assist you in training the others. This helps them 

develop self-confidence and makes them aware of competences they have. 

Here is a step-by-step process to help your audience create an email. First of all 

make sure you explain the importance of owning an email. List all the advantages 

and stress the fact that nowadays it is almost impossible to integrate into the 

professional world without a mailbox. 
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As this is a practical training you need the same number of computers as participants 

and an internet connection.  

Here is a short introduction to inspire you: 

The email is a messaging service offered by internet. It allows you to create a 
virtual space that belongs to you to receive messages. The email address has a 
very important place nowadays, especially in the job search.  
Just like postal mailboxes, virtual mailboxes have the same purpose: to receive 
mail. The fundamental differences between them are: 

 instant message (few seconds before receiving the message) 

 you can send the mail all over the world 

 It is free 
 
There is a large amount of e-mail providers. In our case, we will opt for a Gmail 
account from Google. Google's Gmail account has many great features. 
Therefore, we will focus on email related to the Gmail account. 
 

 

Instructions 

Step 1: Create a Gmail account. Instruct participants:  

By clicking on the link "Gmail- Google", the registration page appears before you 

with a questionnaire that has to be filled in carefully. 

Once you complete the questionnaire, a window on the privacy policy and 

condition of use for your Gmail account appears. Scroll through the crossbar so 

that the "I accept" button becomes clickable. Generally speaking, you should first 

read the conditions before accepting. 

A new page opens where Google welcomes you to your Gmail account. It's time 

to access your email with just a click on the "Go to Gmail" button. 

Here you are on your Gmail! You have 3 emails in your inbox by the Gmail team. 

So let’s break down each element on the screen. 

Step 2: Mail reception zone 

Your reception area consists of 3 tabs: 

o Main, the most important tab where you receive your emails. 
o Social networks, if you link your Gmail account to a social network, you will 

receive notifications and messages in the social networks tab. 
o Promotions, where you receive promotional offers from shops, restaurants, 

etc. 
 

To open a received email, point to it and double click on the left mouse button. 

In front of the name of the email sender (top right) you have a small arrowhead 

looking down (the button "others"), pressing on it you will access several 

https://accounts.google.com/signup?hl=fr
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features. Thanks to this button you will be able to reply to the email, transfer it to 

another contact, report it as spam etc. 

Step 3: Write a new email 

I invite you to click on the New Message button to open your first email (red 

button at the top left of your screen). The first box of the window that appears is 

for the address of the recipient of the mail. The box below for the subject or the 

title of your message (example: application for the job). The next box is where 

you write the text of your email. Once you have written everything, you can click 

Send. 

There are two important features when creating an email. 

- Attach a file 
By clicking on the paper clip (next to the Send button), you can insert a document 

as an attachment to your email. The attachment can be a text document, a music, 

a movie, etc. 

To insert an attachment, simply click on it and a window appears where Gmail 

asks you to select the document you want to add as attachment. Position your 

mouse on the element and make a left double click. Your attachment will load 

directly into your mail! 

- Insert an image directly into your email 
Like the attachment, it is possible to integrate an image directly into your email 

that is visible from the opening of it. To do this, tap the camera icon next to the 

paper clip. You can either select a photo on the Internet or one of your photos on 

the computer. 

Now that you have a solid knowledge of Gmail, send me your first emails. 

Debriefing and Reflection 

Ask the following questions 

o Was this activity of any use?  
o What exactly was useful for you this activity, and what was not? 
o Did you learn something new during the activity? What? 
o Do not hesitate to ask other questions depending on your groups need 
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Activity 2: How to use Word 
 
Title How to use Microsoft Word 

Overview To be able to access the job the beneficiaries must at 

least be able to write a CV, Letter of Motivation, and have 

an email address to receive all the information related to 

the job. This 4-hour session helps you to explain to your 

audience the importance of these tools. The training 

encourages them to take control of these tools for daily 

use. This is a Practical exercise which can be done in 

groups of two or three. Each group will need a computer. 

This entire session is directly put into practice by the 

public. The trainer is responsible for conveying general 

information and answering questions from the public. 

This activity allows participants to create and modify a 

Word document and to integrate the good practices of 

the formatting. 

Type of activity Experimental exercise 

Time required 360 minutes 

Size of the group 10 people 

Materials needed Computers, 1 word document in 2 different layouts, 

Annex 1/1 

 

Procedure 
 

1. Preparation 
Beforehand, prepare a text of your choice in two different documents, formatting it 

differently in each of the documents. Based on those documents, stress out the do’s 

and don’ts of Word formatting.  

2. Instructions 
Step 1:  

Distribute the two formatting examples and let the participants compare them in 

two groups of 5. Describe each document and analyze the good and bad points of it 

all together. Let the participants talk and correct if necessary.  
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Step 2: 

Ask the participants to create groups of 2 or 3 and give each group a computer. Ask 

the groups to create a text with an attractive formatting. Their text should be very 

short, and it can be anything they want to type. If there is nothing on their minds, 

ask them to search for a text on google and copy/past it on their Word document. 

Give them the following handout, as a helping document. Explain the different 

points of this handout. 

At the end you can mention other software like Open Office. You may find a link 

describing how to use it in your language on Google. 

Keyboard shortcuts on Microsoft Word 
 
Like many software, Microsoft Word offers keyboard shortcuts to improve 
productivity. Here are the 15 main shortcuts to know : 

o CTRL+S: save the document 
o F2 : save as 
o CTRL+O: open a document 
o CTRL+N: create a new document 
o CTRL+F: look for text in the document. F5 also works. 
o CTRL+Z: cancel an action, go back  
o CTRL+Y: restore or repeat an action  
o CTRL+P: print the document. CTRL+F2 also works. 
o CTRL+G: put a text in bold. CTRL + I for italic and CTRL + U to underline. 
o CTRL+SHIFT+V: paste only the text. CTRL + V to use the default collage. 
o CTRL+F4: close the window. CTRL + W and ALT + F4 also work. 
o ALT+IMP ÉCR: allows you to take a screenshot of the active window only. 
o TAB: to move to the next cell in a table. SHIFT + TAB to go back.  
o CTRL+Lateral arrow: move the cursor, word for word.  
o SHIFT+Lateral arrow: allows you to select text. 

 
You can try them with your audience, but do not forget to type a text first. 
 
Formatting 
 
To format text on Microsoft Word, you must use the Home tab. Various tabs are 
available in Word: File, Home, Insert, Layout etc. These tabs are then divided into 
sections: clipboard, font, paragraph... The Font section allows you to change the 
appearance of the text: font, text size, bold, underline, italic, strikethrough, 
superscript, index, font color, text effect, highlight color… 
Invite your audience to play with these tools to see how they are working. 
 
Make a frame 
 
In some cases, framing a paragraph may be useful. To do this, simply select the text 
and click on the frame icon in the paragraph section of the Home tab. You will then 
be able to add a bottom, top, side border, or frame a text entirely. To go further, you 
can click Border and frame to customize the background and your borders. 
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Standardize formatting 
 
Styles, on Microsoft Word, are very important. They are accessible via the Home tab, 
and allow you to organize a document. You can apply the "Title" style to your 
document title, the "Title 1" style to the first level titles, and so on. This feature 
organizes your document, standardizes its formatting and allows the software to 
prioritize your contents for the summary. We recommend using styles as soon as you 
create your document. 

 
Insert a table 
 
Just click the Table button and choose the number of lines and columns. For this go 
to the tab Insert/Tables. Once inserted, select your table. A new part will appear on 
the ribbon: Table Tools. Then use the Creation and Layout tabs to format your table. 
 
Date a Word document (date and time) 
 
You can insert the current date and/or time in a Word document. This feature is 
useful if you are printing the document, since it can be updated in real time. On the 
Insert tab, Text section, select Date and Time. A window opens; many formats are 
available, the data corresponds to the day and time indicated on your computer. 
 
Adjust margins and change portrait/landscape orientation 
 
Layout/Orientation tab: Change the portrait or landscape orientation. Depending on 
your needs you may need one or the other, so you choose what you want. 
Margins are useful when you want to play on the shape of your document, or if you 
need extra space in the footnote. Margins can be changed using the Page Setup tab 
also. 
 
Insert a picture 
 
On the Insert tab, in the Illustrations section, click Images and select the one that 
interests you from the computer. To subsequently put the image according to your 
text (behind, aligned or framed for example), please click on the image and on the 
small icon appearing on the right of the image. Then select the way you want to 
position your image. 
 
Add a table of contents 
 
Once your document is organized thanks to the styles, you can add a summary. Use 
the Table of Contents button on the References tab. The possibilities of 
personalization are numerous, from the style of the texts to the characters of 
continuation by way of the levels to be displayed. Then you will have to update the 
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table by hand, by clicking on the dedicated button or by right clicking on the 
summary. 
 

3. Debriefing and Reflection 
Ask the following questions: 

o Was this activity of any use?  
o What exactly was useful for you this activity, and what was not? 
o Did you learn something new during the activity? What? 
o Do not hesitate to ask other questions depending on your groups need 

 

Annexes and Handouts ANNEX 1/1 Computer Literacy Session 1 activity 2, 

“Keyboard shortcuts on Office Microsoft WORD” 

 
 

Session 2: Surfing for a Job 
 

Activity 1: How to Search a Job 
  

Title How to search a job 

Overview This part is particularly interesting for your audience, 

because the purpose of insertion into the professional 

world is directly targeted. So emphasize the importance 

of knowing all the ways to look for a job and apply for it, 

all in a computerized way. 

This activity allows participants to discuss the job 

searching process, exchange on their good practices and 

make a point on their knowledge in this domain 

Type of activity Group discussion and experimental exercise 

Time required 120 minutes 

Size of the group 10 people 

Materials needed Paper, pencil, computers and the handout, annex 1/2 
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Procedure 
 

1. Preparation 
You need to know all the possible ways of job searching procedure. For this refer to 

every material at your disposal. Depending on the country the materials may change, 

so please adapt the research here. Prepare yourself to eventual questions on what is 

the best way etc.  

2. Instruction 

Step 1: 

Ask the participants to list all the ways to find a job they know about, and then 

exchange on this knowledge. Ask them if they have any relevant stories related to 

the job search (in the host country or in the country of origin) and what difficulties 

they face. 

 

Step 2: 

Do the practical application below by creating a Google Alert. 

 

Introduction to the practical application 
 
The development of the Internet and its banalization within households have 
fundamentally changed the methods of job search. Before the creation of the 
Internet, it was necessary to move physically, to scrutinize the newspaper, to 
propose directly to potential employers. In short, an approach where you have to 
look for information, employment. 
With the rise of the Internet, the rules have changed. More and more offers are 
now visible only on the Internet. For good reason, better visibility for employers 
and free advertising. This new methodology is based on the following two points: 

o Standby 
o Network 

 
What is the standby ? 
 
Imagine a large newspaper that you have used to view for some articles that 
interest you more than others, such as the sports page for example. Now, I 
propose you your own newspaper containing only sport articles from different 
newspapers. Nice no? This is the information standby. 
We will enter keywords "cinema", "music" in a standby tool. It, will analyze the 
latest information published on the internet containing the words "cinema" and 
"music". Following this, he will send us regularly links of recent pages using our 
keywords. 
This key word surveillance system is called "alert" because it allows people to 
react quickly to information. Thanks to the information standby, we leave this 
approach of "I seek information" for an approach of the type "the information 
comes to me". This saves a lot of time and improves your chances of finding an 
interesting offer. 
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Put into practice Google alerts  
 
Please go on Google Alerts.  

 
First of all make sure you have filled in the first box with your search item (use 
key words such as job offer for example). Then choose the email address on 
which the alerts will arrive. 
By clicking on the "Show Options" button, a second window opens allowing you 
to specify your Google Alerts. Unless you have a special alert to do, I advise you 
to leave these options by default. 
 
Your Google Alerts results will depend on two conditions: 

o The relevance of your keyword. You have to choose good keywords to 
maximize your chances of results. A good keyword is a short or simple 
word or phrase. Good keyword: cinema. Bad keyword: last film released 
at the cinema. 

o The news, if your keyword comes out a lot or not at all. Take for example 
the word "snail", which is a simple key word but which probably will not 
bring many results because of its little present in the actuality. 

 
I advise you to use broad expressions and targeted expressions as keywords. 
 Broad expressions 

o « Job search » 
o « Job offer » 

If you are only searching in Alsace : 
o « Job search » « Strasbourg » 
o « Job offer» « Alsace » 

  
Targeted expressions 

o «Human Ressources Agent» « Strasbourg » 

https://www.google.fr/alerts
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o «Cashier offer» « Super U » « Strasbourg » 
 
There is another site for alerts. Visit Talkwalker at the following address: 
http://www.talkwalker.com/fr/alerts. As you can see, it works exactly like Google 
Alerts we saw previously. It's up to you to submit your alerts or to program new 
ones as well. 
 

 

3. Debriefing and Reflection 
Ask the following questions: 

o Was this activity of any use?  
o What exactly was useful for you this activity, and what was not? 
o Will you use the Google Alert? Why? 
o Did you learn something new during the activity? What? 
o Do not hesitate to ask other questions depending on your groups need 

 
 

Annexes and 

Handouts 

ANNEX 1/2 Computer Literacy Session 2 activity 1 

“Introduction to the practical application” 

http://www.talkwalker.com/fr/alerts
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Activity 2: How to Apply Online  
 

Title How to apply online 

Overview This part is particularly interesting for your audience, 

because the purpose of insertion into the professional 

world is directly targeted. So emphasize the importance 

of knowing all the ways to look for a job and apply for it, 

all in a computerized way. 

This activity allows participants to learn the techniques of 

online application to a job offer 

Type of activity Experimental exercise 

Time required 120 minutes 

Size of the group 10 persons 

Materials needed Computers and the handout, annex 1/3  

 

Procedure 

1. Preparation  
Please read for yourself the instructions below before starting the activity, so 

that you are ready to lead the workshop.  

2. Instructions 
This is a practical exercise. Each participant should have their own computer to 

facilitate the assimilation of the outcomes. Make sure to be at the disposal of the 

participants for any question.  

Introduction 
 
We will discuss the procedure to apply spontaneously online to an offer that 
interests you. There are a large number of sites offering job opportunities, we are 
going to focus on 2 major employment platforms: 

o Monster 
o Careers 

 
These are job boards, sites posting job offers updated regularly. Whatever the 
platform, it will always be necessary: 

o To have an account on the said platform 
o To own a mailbox 
o Have your resume saved on your computer or create one directly on the 

online platform 
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Monster 
 
Go to the Monster website by typing 'Monster' in Google. We will start by creating 
an account on this site by clicking on the "Register" button. To register you can 
either use your Facebook profile (in case you have one), or fill up the 
questionnaire with your email address. 
Once your registration is over, it is time to go to the second essential step to apply 
for offers: create a CV! 
The next page opens where you are asked to fill in your Monster CV with your 
personal and professional information. It can be long and tedious, so just fill in the 
information you need right now. 
On the other hand, applying for an offer cannot be simpler. Just check if the 
information is correct, attach a cover letter if you wish (which is recommended) 
and click send! 
 
Indeed 
 
Indeed offers you the choice to respond to job offers by directly integrating your 
CV or by creating a CV directly on the platform. 
To do this, you need to create an Indeed account. The advantage of having an 
Indeed account is to be able to receive job alerts, a thing that is not possible 
without registration. 
Indeed is a different job board. It lists the offers but does not offer to apply 
directly. It refers to the site in question or the job offer is proposed (ex: return to 
the site of Buffalo Bill to be a maintenance agent) Therefore, there is not a single 
path to apply as on Monster. However, you realize that it is still easy and intuitive! 
Some offers will however require you to create another account "candidate space" 
on the recruiter's website. 
 
In some cases, you will be asked to write a message on the platform or to send an 
e-mail to someone to express your interest in the job offer. I propose a simple and 
effective message that you can put in the majority of cases. 
"Hello, I allow myself to contact you after the publication of your offer ... on the 
site ... 
You will find attached my CV in response to your offer. 
Do not hesitate to contact me for any additional information. 
Sincerely 
LAST NAME AND FIRST NAME» 

 

3. Debriefing and Reflection 
Ask the following questions: 

o Was this activity of any use?  
o What exactly was useful for you this activity, and what was not? 
o Will you make applications online? 
o Did you learn something new during the activity? What? 
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o Do not hesitate to ask other questions depending on your groups need  
 

Annexes and Handouts ANNEX 1/2 Computer Literacy Session 2 activity 2, “How 

to apply online”  

 


